
“What turns me on about the d ig i ta l  age , what  exc i ted me per sona l ly, i s  that 
you have c losed the gap between dreaming and doing . You see , i t  used to be 

that  i f  you wanted to make a record of  a  song , you needed a s tud io and a pro-
ducer. Now, you need a laptop. “
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P H O T O  M E C H A N I C
gett ing your photos  from the  camera to  the  computer

http://www.camerabits .com

Photo Mechanic is an image browser. 

With it you can:

1. Look at your digital photos

2. Import them from the camera onto a computer or harddrive

3. Caption

4. Sort

5. Edit

Using the features of Photo Mechanic is the first step to staying organized and sane as you work with 

large numbers of digital images.
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USING PHOTO MECHANIC

 Getting Photos There To Here
 (or, how do I get photos from my camera to the computer?)

1.Insert your digital card (SD card) into a card reader

2.Open Photo Mechanic

3.Select ‘Ingest’ from the ‘File’ Menu (or ⌘G)

4. You should see the screen below.  

! P h o t o  M e c h a n i c
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1. Select  and highlight your card in the box in top left. DON’T select other drives that might 

appear such as external hard drives.

2. Change ‘Copy Photos:’ drop down to ‘into folder with name’. Name your folder

3. Select ‘Primary Destination’:  I suggest either desktop or your external drive when in the lab.

4. Enter caption info using ‘IPTC Stationary Pad’ (see below)

5. Click ‘Rename Ingested Photos As’ to rename all your files

6. Check the’ Rename Ingested Photos As’ box to apply your captions to your images

7. Click ‘Ingest’ to begin.

IPTC Stationary Pad

You can add a bulk caption to all your images at one time (returning later to add specifics to indi-

vidual images)

Why Do This?

1. Will save you LOTS of time later on

2.  Makes all your images immediately searchable
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Caption:
Enter the basic facts of the assignment and your photo credit. 

City, Location, State, Country
All of this is searchable later and can be useful

Date
Date the assignment was shot. Change this from ‘Today’ if necessary.

Photographer, Credit, Copyright
Extremely important to have your name attached to your images. 

TIP
   ‘option G’ will create the copyright logo

Email and URL
scroll down and enter your email and website if you have one

TIP
IF you use an external drive you can save this information and load it each time you use Photo  
Mechanic. (Unfortunately the lab computers erase data each night so you can’t save it on the  
! P h o t o  M e c h a n i c
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computers)

   Click ‘Save…’ at the bottom to save a caption.  Click  ‘Load…’ to install a previously save caption

Working With Your Photos

After ingesting your photos, you’ll get a Photo Mechanic ‘contact sheet’ of your images.

Rolling your mouse over an image will reveal the tools as shown in the circled photo

Photo Mechanic Basics
Photo Mechanic can do many things for you.  This tutorial will cover the basics; browsing, organizing 

and captioning your images

1.  A contact sheet shows you the images in one folder.  You can have multiple contact sheets open 
at the same time.

2.  Select an image in a contact sheet by clicking on it:
TIP

Use Shift key to select multiple photos. Use the Command key to select non-contiguous photos

! P h o t o  M e c h a n i c
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Curved arrows rotate the photo
“i” opens the caption dialogue box (more about that soon)
Magnifying glass shows a larger version of the image

In contact sheet mode you can:
 ‘tag’ photos – click the small box in the lower right of each image
‘rate’ photos – add one to five stars by clicking on the circles at the bottom center of each image
Assign color code to photo(s):
	

 select image(s) and go to the tool bar : Image/Set Color Class

TIP
⌘1, ⌘2, ... ⌘8 will assign different colors. ⌘0 will remove a color

CAPTIONS
Click the ‘i’ button to view the caption

! P h o t o  M e c h a n i c
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In this field you can change/edit/expand your captions for this individual photo.

TIP
Note the red circle If you are captioning multiple photos you can copy this caption, click ‘Save &…’ and 

then paste the same caption in the next photo. This can save you a LOT of time.

PREVIEW
Click the magnifying glass under an image in a contact sheet to enlarge the view:
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From this view you can scroll through a contact sheet

TIP
Use the left and right arrow keys on the keyboard to scroll

Tag and star images in this field as well.

TIP
The ‘t’ key will tag a photo

control 1, control 2….control 5 will add the equivalent number of stars

Click the ‘zoom’ box and use the slider to examine details in a photo

While you can crop in Photo Mechanic, it’s generally easier to save this step for PhotoShop

Finally
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•You’ve used Photo Mechanic to view, edit and caption your 
images. 

•You’ve selected the ones you want to use.

•Now What?

Create a folder of Edited Images by copying your selects:

IMPORTANT:

ALWAYS WORK ON COPIES OF YOUR ORIGINALS - NEVER TONE OR 
CROP OR SIZE THE ORIGINAL FILE

From Menu: File/copy photos or ⌘Y

TIPS

Click ‘Always pick destination’ to create a new folder for the images

Click Open destination as a Contact Sheet to immediately see the new folder

Opening in Photoshop

You can open images in Photoshop directly from Photo Mechanic for toning/cropping

Select images from your new folder 
! P h o t o  M e c h a n i c
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REMEMBER: 

NEVER TONE OR CROP ORIGINALS. 

ALWAYS WORK ON COPIES

From menu: Image/Edit Photos or ⌘E to open the images in Photoshop

TIP

If the Image(s) open in some other program, change the preferences in Photo Mechanic

Menu: Photo Mechanic/Preferences or ⌘,

Click on ‘Launching’ tab

Questions?   Just ask.

! P h o t o  M e c h a n i c
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P H O T O S H O P
An introduction to  image processing

http://www.adobe.com

Photoshop is a sophisticated image processor and more.

It is extremely powerful. 

“Power corrupts, and absolute power corrupts absolutely”

There are many stories of journalists losing their jobs and ending their 
careers because they abused the power of Photoshop

Just because you CAN do something, doesn’t mean you should. The 
rules and standards of journalistic ethics apply to our use of Photoshop
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With Photoshop you can:

1. Look at your digital photos

2. Adjust their tone/color/contrast

3. Crop

4. Resize

5. Caption

An understanding of the basics of Photoshop will give you control of your images

USING Photoshop

Basic Tools:

Open photos from Photo Mechanic or by using File/Open (⌘O)

You should see something like this screen

TIP

You can arrange Photoshop in a variety of ways.  And you can save arrangements by going:

Window/Workspace/New Workspace...
! Pho t o shop
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marquee tool (M) - allows you to select an area of an image by clicking and dragging

lasso tool (L) - select an area of an image by drawing a shape around it

quick selection (W) - Photoshop selects an area of similar tone automatically

crop tool (C) - click and drag a box to crop the image

eye dropper (i) - use with info panel to measure tone and density in an image

healing brush (J) - use with care to remove sensor dust

clone tool (S) - use with care to remove sensor dust

history brush (Y) - use with history panel as a toning tool. 

burn tool (O) - lighten and darken selective areas of an image

type tool (T) - apply type over an image. NOT for daily use.

TIP

The small arrow in the corner of each tool icon 

indicates a submenu of similar tools. 

Click and hold the icon to see that menu



ToolBar:

Photoshop has MANY tools. We will only explore a few of the ones that are commonly used for 

our purposes
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Photoshop 10(ish) Steps
Properly exposed and photographed images should NOT require extensive toning.

Photoshop is NOT the fix-it tool for lazy and bad photography.

If you get it right in the field, it should take less than 10 minutes to tone a photograph

Steps towards a quick, accurate and repeatable method for toning digital images:

ALWAYS WORK ON A COPY – NEVER YOUR ORIGINAL FILE!!

1. Analyze
2. Rotate and Crop
3. Basic Tonal Adjustment using Levels
4. Color Cast Correction
5. Midtone Adjustment
6. Dodge and Burning - Use History Brush
7. Selective Color
8. Correct Detail Loss
9. Caption
10. Save File
11. Format Card in Camera

Step 1 - Analyze overall image Contrast, tonal qualities, and sharpness. Check tonal values for 
faces in info palette: ~36% K Value for front lit Caucasian skin and up to 70% for African American 
skin tones

TIPS
Select the eyedropper tool, and then set the ‘sample size’ at the top left to 3 by 3

! Pho t o shop
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In the info palette set second ‘eyedropper’ to grayscale 
Read the skin tone with the eyedropper - avoid highlights or shadows when looking for skin values

Step 2 - Rotate and Crop (C)

Step 3 - Basic Tonal Adjustment Use Levels (⌘L) to adjust Black and White points
Drag the black and white points to the base of the curve

BEFORE

   

AFTER 

  

! Pho t o shop
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Step 4 - Check for Color Cast 
Check for color cast using the Info Palette and RGB numbers. Select a clean neutral or gray with a 
K value between 8-35% The RGB values should be within 10- 15 points from high to low.

Notice the low blue channel number - this image has a yellow cast

If not: Use the Correct Color Cast method below

Correct Color Cast

• Open Levels ⌘L. 
• Double click white eye dropper and place over a clean neutral or gray with a K value between 8-
35%
• Click once at this spot and don’t move the mouse. 
• Click the Tab button to move through to the a and b values and change both to zero. 
• Click Return 
• .Click the Mouse (without moving it) to set the new white
• This should bring you close to a neutral scene

! Pho t o shop
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After setting white. 
Notice the colorcast is gone and the rgb numbers are nearly equal

Step 5 - Midtone Adjustment 
Use Levels ⌘L to adjust the tonal range by adjusting the middle grey tab, and the black and white 
points if necessary.

TIP
You can also use curves (⌘M) to adjust the midtones. Curves offer more control

Step 6 - Local adjustments - brighten or darken specific areas of the image using the burn/
dodge tool and/or Levels combined with the history palette.

Step 7 - Selective Color (Image/Adjust/Selective Color) Use with care. You don’t want to suck 
all the color out of an image.
! Pho t o shop
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You use this to remove color casts – NOT change the color.

This subject’s face had a lot of red in it.  Add cyan and yellow to the red channel to fix

   before	

 	

 	

 	

 	

 	

 	

 	

 after

  

Step 8 - Correct Detail Loss Using Photoshop’s Unsharp Mask Filter/Sharpen/Unsharp Mask

TIP
You can’t fix an out of focus photo. Sharpening just brings out detail that is already there

DON’T oversharpen since it can’t be undone. 

! Pho t o shop
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Step 9 - Caption  if you didn’t use Photo Mechanic – caption in Photoshop:  File/File Info

Step 10 - Save as 
Use a naming convention to create a unique name for every file

TIP
Be Organized. Use a naming convention that will allow you to find images. 

A common method is to start all files with yyyymmdd - 20110115 - this way images sort by year. 
followed by a one or two word slug:  20110115_feature_cats (avoid spaces, use underscores)

But use any method that makes sense to you.

How much is a $100 bill worth?
How much is it worth if you can’t find it?

Step 11 – Format the Card in Camera Use the camera to format the card, never delete files 
off a card from the computer. 

DON’T reformat until you are SURE you have properly saved your images.

! Pho t o shop

10



U s i n g  s o u n d

by 

Will Yurman
Senior Lecturer

Penn State University
www.willyurman.com/links

“Long befo re I  wrote s to r ies , I  l i s tened fo r  s to r ies . 
L i s ten ing fo r  them i s  someth ing more acute than 

l i s ten ing to  them.
– Eudora Welty
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Why Sound?

For some of us the answer is easy - because our bosses say so.

But audio offers chances to tell stories in ways that just aren’t possible with images alone. Great 
audio is engaging, emotional and informative.  

For years, we have given our photographs context by adding words – captions, text blocks, 
essays, etc. – and that can be a powerful combination.  Sound does the same thing, only better.  
A viewer can look and listen at the same time.  They no longer need to turn away from the 
image to read the context.  

A well-edited audio track with strong images – video or stills – is a compelling way to tell 
stories.  And gathering sound while photographing makes us better journalists by forcing us to 
spend more time and thought on a story. 

It is also hard work, which requires more time, more energy, and more skills.

Sound has become a crucial part of storytelling on the web.  Adding a soundtrack to your 
images gives depth to your storytelling. Good sound can make a story.  Bad sound will send 
your audience running – to someone else’s website.   

Audio will almost always drive the story.  Imagine watching your local news tonight.  Would you 
rather turn off the picture and listen, or try to figure out what is going on by looking at the 
video without sound?  We have become storytellers not ‘just’ photographers.

Hardware
There has been a boom in portable, affordable recording equipment. There are increasing 
numbers of digital solid-state recorders that offer the potential of dependable, easy-to-use, high-
quality audio.

In the past few years a number of new recorders have been released.  All offer various 
combinations of quality, ease of use, size and price. There is, unfortunately, not one perfect 
recorder. You will need to decide based on which best suits your needs and pocketbook.

Based on price, recorders seem to fall into three categories:

1. Low-end – under $100

2. mid-range – $200 - $600

3. high-end – $1000 and up

Low-End
You get what you pay for, but on a limited budget there are a few choices. Sound quality will 
range from poor to decent, depending on the recording conditions. 
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Olympus makes a line of inexpensive digital recorders for dictation. These are not to be 
confused with their more expensive audio recorders. 

Olympus WS-600S ~$80 records compressed audio. Small, easy to use. Built in USB 
connector makes it plug and play. Decent audio in quiet environments. Not a professional tool

Zoom HN1 ~ $99 the newest and smallest recorder from Zoom. Uncompressed audio. 
Reviews are good for the money.  Small form factor means many controls are buried in on 
screen menus.

Tascam DR-07MKII ~$149.  OK, it’s not under $100. New from Tascam, certainly in the 
low-end price range, with uncompressed audio, and small form factor. 

Mid-Range
It is the mid-range that probably is of interest to most of us – offering the best compromise of 
quality versus price. And luckily it is possible to get very good sound quality from these 
machines. 

This list is not intended to be complete, just an introduction to the possibilities.

This list has gotten long.  Great gear reviews (and other info) at www.transom.org (I have only 
used the Marantz 660. The other info comes from various reviews and websites.)

	

 Marantz PMD 661 ~$599 The latest update from Marantz. Very good sound, XLR 
connections. larger than some of the others. 

	

 Marantz PMD 620 ~ $379 Small, good sound, no XLR.

	

 Zoom H4N ~ $299 some complain of hiss but very popular with DSLR users for it’s 
small size. XLR connections

	

 Fostex FR-2LE ~$599 great sound, XLR inputs. Larger and more expensive than 
others in this category. Flimsy battery cover

	

 SONY PCM -D50 ~$499  Good sound with built-in mics, but sensitive to wind.  Very 
good sound with external mic. No XLR

	

 SONY PCM-M10 ~$220 Baby brother to the D50 above, smaller, a few less features

	

 Olympus LS-11 ~ $299 Good sound, decent built-in mics, No XLR.

Tascam DR100 ~ $290  XLR inputs. Well reviewed.  Transom recommends higher 
output mics for this recorder

Microphones 
Audiophiles argue about microphones the way photographers argue about lenses.

And just like the camera/lens marriage, if your funds are limited, it’s probably better to spend on 
a good microphone and cut costs on the recorder.
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Microphones come in various styles.  They can be broken down into several categories:

Dynamic vs Condenser

Dynamic microphones need NO external power and tend to be pretty tough. They tend to be 
less sensitive than condenser mics. 

Condenser microphones do require power, some use a battery some draw from the recorder.  
They tend to be slightly more fragile.  (Marantz recommends condenser mics for the PMD 
660, Transom.org recommends condenser mics for the Tascam units for example because of 
the higher output of condenser mics.  Check the specs of your recorder before purchasing a 
microphone) 

Pick-up patterns

This is analogous to the angle of coverage in a lens.  Different patterns will be appropriate in 
different situations. Though there are also very good mics that can be used in a variety of 
situations for those of us on a limited budget.

cardioid - maximum sensitivity in front of the mic. Sounds to the sides and especially 
to the rear of the mic are largely rejected, or at least attenuated.

shotgun mics - these are basically extreme cardioid mics – The equivalent of a telephoto 
lens.  Useful when the subject is far away. Keep in mind though, microphones don’t magnify 
sound the way a telephoto lens magnifies the image. Shotguns simply reject sounds off to the 
side, isolating sounds from further away.  The best sound quality will always happen when you 
are close to the source

omnidirectional - pick up sounds in all directions equally. Because off-axis sounds are 
picked up more accurately and naturally, the mics create a more realistic sound. Good 
from crowd noises, not so good when you’re trying to interview someone in a noisy 
environment and want to reduce the distractions of the background.

Lavalier mics

Small mics that clip onto a shirt or collar.  They can be inexpensive.  Any small movement by the 
subject can create noise in the mics - so be careful with them. Videographers use them for 
interviews because they are unobtrusive. I prefer a good handheld for straight audio interviews.

Wireless mics

A great option for getting natural sound.  Hook up your subject and let them loose.  They come 
in all price ranges.  You get what you pay for.
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The Sennheiser - Evolution G3 100 Series ~$600, is probably a best buy – often 
recommended as the best ‘inexpensive’ wireless. But there are many many options out there.

Wireless mics can be great when you want natural sound of someone doing something, or just 
to be cord free. BUT they can also fail at the worst possible times – batteries die, interference 
from outside sources can wreak havoc, the subject can pull off the mic accidentally – have a 
backup plan.

A starter list of microphones

Various mics in no particular order that have been recommended by different sources.  
Transom.org among others has reviewed many of the mics below as well:

1. Sony ECM-CR120 - an inexpensive lav mic that works well with the Olympus 
dictaphone style mics  ~ $75

2. Senheisser ME-66 a short shotgun mic - very good quality. Part of the Senheisser 
modular system. With the K-6 power supply ~ $500. (The power supply can then be 
used with other mics)

3. Audio-Technica AT825 Cardioid stereo condenser mic. ~$350

4. Audio-Technica AT897 a short shotgun condenser mic.   ~$250

5. Audio Technica 8010 inexpensive omni mic with high output. A good choice for the 
less expensive recorders which need higher output mics

6. Shure SM58 A dynamic cardioid mic. Known as a workhorse.  ~ $100

7. Electrovoice 635A A dynamic omnidirectional mic.  ~ $100

8. Sennheiser - Evolution G3 100 Series - wireless-    ~$600

Software

IF you record to a solid-state device like a compact flash recorder, getting sound on to your 
computer is as easy as connecting the card and dragging over the files. 

Once the sound is on your machine you’ll want to edit what you’ve got.

There are several software programs available for editing sound.  Commercial programs can be 
quite expensive, though they offer the most features. Final Cut Pro comes with its own 
standalone audio editor – Soundtrack Pro. 
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For photographers on a budget, the program that offers the most bang for the buck is probably 
Audacity.  NOT because it is the greatest program, but because it is free.

Available for Mac, PC and Linux, Audacity allows basic and some advanced editing features.  It is 
an open source program, so support is limited to the forums and the goodwill of volunteers.  It 
is occasionally buggy, but does work.

AUDACITY

Download at http://audacity.sourceforge.net/

Audacity currently is available in two versions

	

 1.2 – their ‘stable’ version

	

 1.3 – their beta version. This version has many more features, and seems to be as stable 
as 1.2.  It is recommended for the latest operating systems (Windows 7 and newer Mac 
OS). Some companies won’t allow you to install a beta version.

In addition to the program itself, you should download the free LAME plug-in for creating mp3 
files from the plug-in page.

Editing sound is very similar to editing text - you cut, copy and paste pieces of the sound 
together to create a compelling narrative. Often you will combine natural sound with interviews 
and your own narration.

Audacity’s interface is pretty simple.  

Open your sound file, Audacity recognizes all common file types.

A single track, mono recording will look something like this: (stereo recordings will have two 
waveforms)

Sound
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The waveform represents your sound.  Audacity’s tools and controls are above.

TOOLS

1.Selection Tool - This is the main tool you use to select audio.

 2. Envelope Tool - The envelope tool gives you detailed control over 
how tracks fade in and out, right in the main track window.

 3. Draw Tool - Enables the user to draw in to the actual waveforms to try and fix 
pops and other noises.

 4 Zoom Tool - This tool allows you to zoom in or out of a specific 
part of the audio.

 5. Time Shift Tool - This tool allows you to change the relative 
positioning of tracks.

 6. Multi Tool - lets you access all of these tools at once depending on the location 
of the mouse and the keys you are holding down.

You will use the Selection and Time Shift tools the most.  ‘D’ on your 
keyboard lets you scroll between the tools.

  Selection Tool

Sound



Click and drag over an area of the waveform to select it. Now you can cut, copy or paste as well 
as apply any of the filters in Audacity to the selection.

 Envelope Tool 

The envelope tool gives you detailed control over how tracks fade in and out, right 
in the main track window. Clicking on the track sets points you can then adjust.

For simple fades, you can also select a small section of audio, and use the 
fade in or fade out effect from the drop down menu.

 Time Shift (or move) Tool 
This tool allows you to change the relative positioning of tracks.
Simply click on a track to slide it along the timeline.

Sound



New Track 

Allows you to create multiple tracks for overlapping sound and transitions. If your file is a 
stereo track, select New Stereo Track.

Generate > Silence

Sound



Allows you to create silence of any length - useful for transitions.  Though better to use 
background sound gathered on location. It will sound more natural.

Effects

Audacity offers many filters and effects.  Amplify allows you to raise or lower the volume.

Fade in and Out are quick ways to create natural sounding transitions.

Exporting your sound

Sound



Audacity creates it’s own file type. Keep all these files together. Moving them or changing their 
names will create problems for Audacity. (and you)

The .aup is the sound file and it is not recognized by other programs. So after finishing editing, 
the sound must be exported for use. If your final use allows, export in an uncompressed format:

.aiff for Macintosh and .wav for PC

If you must export as an mp3 use Audacity preference settings to select a high quality setting. 
You will need to have installed the free LAME plug-in to export as an mp3.

Audacity settings for output:

Go to preferences to set your output - aif for Mac, .wav for PC. Also select a high bit rate for 
mp3 export. 

   

To Export:

  this will say wav or aiff depending on preference settings

Sound



Sound Gathering

Many of the skills that make us photographers will help us gather sound.  You need to pay 
attention, be patient, stop and listen to the world around you.  

There are a lot of great resources on the web for learning how to gather sound.  Check my 
links page for some.

A few thoughts:

Just because audio is new to us,  doesn’t make it interesting. Don’t get 
too attached to your audio…be creative getting it, and then edit!

Get close – physically and emotionally.  Audio is an intimate medium. Not all your 
subjects will trust you with their feelings right away – you have to earn that privilege.

If you’re not enthused about your story, why should anyone else care about it? 

	

 "If something is boring after two minutes, try it for four. If still boring, 
	

 	

 	

 then eight. Then sixteen. Then thirty-two. Eventually one discovers that 
	

 it is not boring at all." --John Cage.

TECHNIQUE
Interview your subject in as quiet an environment as you can.  Take a moment to listen. 
- hear that fan?  that clock ticking? the cars outside?
Find an empty office, unplug the fan if you can, move to the quiet side of the house.  A 
car makes a decent studio in a pinch. Carpet, couches, curtains, are all your friends – 
muffling the sound in the room, reducing echoes.

Get your microphone as close to your subject as you can – ideally about four inches 
(the width of your fist) from their mouth. (a little further away with a shotgun mic) Keep 
it in roughly the same place throughout the interview, and try to keep it as steady as 
possible. 
If you move too much, the microphone may pick up the sounds of your motion or your 
hands rubbing on the mic.

Some subjects get nervous when the mic gets close.  Your job is to put them at ease.  
You do this by looking them in the eye and showing them with your face that you are 
attentive.  Look at them, not your recorder. 

Get them engaged and interested and they will forget about the microphone.
•	

Wear headphones so you can hear what your recorder is hearing. 
•	

Don’t let your subject hold the microphone. 

Sound



•	

 Listen carefully as your subject talks.  Having prepared questions is a good 
thing.  But don’t be rigid.  Follow up on what they say, go where the interview 
takes you.

•	

 Listen not only to the content of what he or see is saying, but the quality of sound 
and how their words may or may not work for your story. 

•	

 You CAN’T talk – unless you want your voice on tape. Nod and use body language 
to uphold your part of the conversation.

•	

Don’t interrupt (unless the interview is going nowhere. But better to get 
something useless than step on a great thought). 

•	

Don’t say “uh, huh” or “hmmm,” don’t laugh out loud.  Nothing is worse than 
having a great quote with your voice stepping on it.

•	

 Phrase your questions so they can be answered as a complete thought. 
	

 	

 “Describe for me....” 
	

 	

 “Give me a sense of....” 

	

 •Silence is your friend.  Wait…watch…let people think and talk.

MOST people are not storytellers.  They aren’t so good at describing the process.  But 
people CAN talk about their feelings and emotions and thoughts.  If you find a great 
storyteller, bless you.  You can let them tell their story.  But generally you’ll get the best 
audio by getting people to describe how something felt, NOT how it happened.  Use 
captions, text blocks, a narrator to get the basic facts on the table. 
Less is more

Most  journalists who start to gather audio fall in love with it.  And they tend to be terrible 
editors at first.  Just because it is new and cool to you, doesn’t mean your audience will be 
equally enthralled.  Your competition isn’t other photographers any longer –  it is NPR, 
broadcast TV, anyone and everyone on the web with a homepage and recorder.

EDIT TIGHTLY.  Keep it interesting and compelling. And have fun.

Sound



F I N A L  C U T  P R O
An introduction to  Video Edit ing

http://www.apple.com

“We realized that the important thing was not the film itself but that which the film provoked.”

—Fernando Solanas ("Cinema as Gun")

“Every cut is a lie. It's never that way. Those two shots were never next to each other in time 
that way. But you're telling a lie in order to tell the truth.”

—Wolf Koenig

FINAL CUT PRO (FCP for short) is a non-linear video editor. 
You can edit your video in any order you want, and access the beginning, middle and end of your 

video simply and quickly.

It is also non-destructive. This means you can cut, delete, move, change and adjust your video 
and audio happy in the knowledge you haven’t destroyed anything.

*This is designed as a get-started tutorial NOT a  complete Everything You Always Wanted To 
Know About Final Cut Pro And Were Afraid To Ask tutorial.

IT is specifically written for Final Cut Pro 7

revised 3/11

    



GET READY
Setting up yourself and FCP 

Before you even open the program though, it’s extremely important to get 
organized.  FCP is complicated.  Video is complicated. There are many files and 

folders and it is very easy to ‘lose’ stuff.

Get Organized. Stay Organized.
	

you will thank me later.

Create a Project Folder for every, er, project.
	

	

 This folder will hold everything associated with your project. Here is a 
sample system - the exact naming convention is less important than being consis-
tent and logical: 

Some folders will hold the content you create:
Audio, stills, video files, graphics will go into their appropriate folders.
FCP generates render and cache files, sequences, etc and we will ‘direct’ FCP to 
place files in these folders.

DO THIS. And your project will exist in a single place. You can copy it to an-
other drive, give it to another person to edit.

DON’T DO THIS and files will get lost.  projects won’t work, your harddrive will 
fill up and you will go crazy.

 

NOW, open the Final Cut Pro application.
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TIP
•

Many of the terms we use 

in video editing come from 

the days of film and razor 

blades and linear, ‘do it by 

hand’ editing.

•



You may get this warning screen:

        

By default, FCP looks to see if a video camera is connected. 
Click ‘Continue’ unless you want a camera connected at this point and it isn’t. 

1. Save your Project:  name it the same as your Project folder : 
Date_YourName_ProjectName
Save it into the _FCPsequences folder inside your Project Folder

2.  In FCP, go to Final Cut Pro/Systems Settings: (this is where you’ll tell FCP 
where to save all the files it creates.

3. Set the paths for the render and cache files to the RenderAndCache 
folder you created:

! F i n a l  C u t  P r o

3

TIP
•

Many of the terms we use 

in video editing come from 

the days of film and razor 

blades and linear, ‘do it by 

hand’ editing.

•

TIP
•

IF you are using a tape 

camera, connect it to your 

computer and turn it on 

before starting Final Cut 

Pro

•



	

Click the four ‘Set’ buttons and direct EACH to the project’s RenderAndCache 
File.

	

NOTE:  You must do this each time you open a project, especially on a new 
or shared computer.  Without these files you may not be able to re-open a pro-
ject.

Click OK

FCP will continue, and your screen should look like this:
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TIP
•

IF you don’t set up your 

project folder properly, im-

portant files will be stored 

in the wrong place. On the 

school computers these 

files will be deleted over-

night and you will be very 

sad.

•



GETTING VIDEO INTO FCP

First, we need to tell FCP what kind of video we will be using.
The exact settings will vary depending on which camera you were using

Go to: Final Cut Pro/Easy Setup

You will see this dialogue box:
We typically will shoot HD so set the format to HD
For most of the cameras we use, 1080i60 is the appropriate setting (but double 
check in class - the Nikon D90 is one exception)

Click ‘Setup’

What happens next depends on what type of camera you are 	


	

 	

        using:

1. Tape Cameras
2. Hard drive or card based devices
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Tape Cameras
The camera must be plugged in and turned on before opening Final Cut.
Rewind your camera to the start of the video you wish to ingest

	

 	

 	

 Go File>Log and Capture

With some cameras, FCP will automatically begin to play the tape and ‘capture’ it. 
Sit back, relax, wait. 
With some cameras you’ll get this window and have the option of naming your 
files. Then click the ‘Now’ button, sit back, relax, wait

When FCP is done, save your project, turn off the camera and disconnect it. It’s 
important to disconnect the camera so you don’t confuse FCP.

Hard Drive cameras

If your camera records to a solid state drive or SD card:

Use a card reader to copy the digital files to the ‘video’ folder in your project 
folder.  The exact workflow will depend on which camera you are using.

For some cameras use the Log and Transfer function in FCP.
Some camera files can be imported directly in FCP by going flie/import

Check in class for which method to use
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TIP
•

Ingesting tape is a real-

time experience.. Shoot 30 

minutes, wait 30 minutes 

to ingest. Make sure you 

plan accordingly

•

TIP
•

IF your camera uses a card, 

make sure to copy the 

whole file structure into 

your ‘video’ folder - not just 

the movie files. FCP needs 

the various folders to prop-

erly recognize the video

•



EDITING
phew….all that work and we haven’t even begun to edit video!

At this point you should have a project window that looks something like this:
The standard arrangement of windows

There are four panels and a variety of controls and tools. Here are some basics:

1. Browser - it shows all the media (video, stills, etc.) that you have imported 
into your project. It’s the file cabinet.

2. Viewer - from here you look at what is in your Browser. Double click on a 
video clip in the browser and it will appear in the Viewer window. From here you 
can play the clip and set in and out points and drag it to the Timeline.  You can also 
view what is on the Timeline here - to edit, color correct, etc. Double click on 
video on the timeline and it will show here AND in the canvas.

3. Canvas - This window shows what is on the timeline. as you play the movie 
on the timeline it will play in this window.

4. Timeline - this is where you edit and build your movie. By placing clips and 
then cutting them up and rearranging them into a compelling story.
You can have multiple video and audio tracks and create very complex effects.

5.Tools - you can access tools from the tool bar or thru keyboard shortcuts . 
Roll over a tool to see its name and quickkey.  To start, rely on the Selection 
tool (a), the top arrow, for selecting and dragging around clips and the Blade 
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TIP
•

IF you rearrange your win-

dows and want to return to 

this standard view go to 

Window>Arrange>Stan-

dard or ‘control U’ on the 

keyboard

•

TIP
•

You can import all sorts of 

media into FCP – still pho-

tos, audio, graphics. FCP 

prefers uncompressed me-

dia so save your photos as 

tiffs and your audio as an 

aif or wav file for best re-

sults.

•



tool (b) for cutting up clips into pieces.

Here’s an example of a relatively simple project:

The timeline contains multiple tracks of audio and video.  Note the scrubber in 
the timeline. It is the thin grey vertical line with the yellow triangle tab.

The scrubber shows the current play position for the video. So wherever the 
scrubber is on the timeline, shows in the Canvas window, top right.  You can drag 
the scrubber by clicking in the grey bar where the yellow tab is. You CAN NOT 
grab the scrubber in the middle.

Typically, you’ll look at video clips from your Browser in the Viewer and decide 
which parts you want to use.

So, for example, you would double click on a video clip in the browser, and it would 
appear in the viewer window.  You can click play or use the keyboard shortcuts 
j,k,&l to play the clip.

Set ‘In’ and ‘Out’ points to select a portion of this clip and then simply drag that 
portion onto your timeline.
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TIP
•

To control the scrubber 

and play your timeline:

The space bar will stop 

and start the movie.

The keys J, K, & L will re-

wind, stop and start the 

movie, in that order.

Double clicking the J or L 

keys will speed up the 

play, either forward or in 

reverse.

•

The more keyboard short-

cuts you learn, the faster 

editing video becomes.

•



For Example:

Setting “In” and “Out” Points 

In and out points set the starting and stopping points in an edit.  Most of the time 
you’ll be setting “In” and “Out” points in the Viewer window. 

Set an ‘In’ point by using the letter ‘I’ key.  Use ‘O’ to set the ‘Out’ point.  Play the 
video in the Viewer and click ‘I’ at the start of a portion of video you are interested 
in using.  Clicking  ‘I’ again will reset the ‘In’ point.  Click ‘O’ to set the end of that 
clip.
Perhaps you need the first three seconds of a video clip. Set those In and Out 
points, drag that three-second clip to the timeline. Return to the Viewer and per-
haps grab another four seconds from the middle of that clip by setting new In and 
Out points.
As you edit your video your timeline will accumulate a selection of clips that you 
can move and rearrange by using the select tool. Simply click on a clip on the time-
line to highlight it - click delete to remove it, click and drag to move it on the time-
line.

Editing a video clip

Once a video clip is on the timeline, you can still edit it:
1.Move it using the selection tool. Click and drag. 
2.Cut it using the blade tool. Place the blade tool wherever you like, and click to 
splice that clip into two pieces.
3.Shorten or lengthen a clip by using the selection tool. Click on the end of a 
clip and drag it to shorten or lengthen it. 

NOTE that, for example, you can splice a clip, delete one piece, and then restore 
your cut by simply dragging out the length of the shortened clip.

Understand the notion that shortening a clip by dragging in one end is exactly 
! F i n a l  C u t  P r o
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TIP
•

common keyboard
shortcuts:

I – In point
O – Out Point 
J- plays clip backwards
K – Stops playback
L –plays clip forward
B –  Blade tool
A – Selection tool
N – Snapping

⌘ Z – Undo

⌘ S – Save
Space Bar – Play / Pause

⌘ 8 – Capture
Ctrl G – Closes gap in 
Timeline
Left and Right Arrow 
Keys – Move backward 
and forward one frame
Ctrl U – Returns the 
windows to the standard 
setting

•

The arrows show the ‘in’ and ‘out’ points set on a clip in the Viewer. As 
you click and drag the clip down to the timeline notice the arrow cir-
cled in red. 

As you drag the clip to the timeline you can either overlay it on top of 
other clips. or insert it, splitting them apart.

If the arrow is down, as it is here, it will overlay. If you move the clip 
up a bit before releasing it, the arrow will become a horizontal arrow, 
which indicates it will insert itself, splitting the clip.  Try it – it’s easier 
to do, than to explain.



the same as cutting a clip and deleting one piece. And both can be undone easily.
TRACKS

You can have as many tracks as you like.  By default FCP opens a timeline with one 
video and four audio tracks (two stereo tracks). 
To add a track:
Sequence>Insert tracks
OR
simply drag audio or video onto the timeline above or below an existing track. FCP 
will automatically create a new track for you.

AUDIO

Generally, you’ll want to see the audio waveforms. this can help you find good 
edit points and let you ‘see’ your sound.
TO display the waveform:
Click the small arrow at the bottom, left, of the timeline and select Show Audio 
Waveforms

TO adjust the audio levels, you need to display the “Clip Overlays” button. Turn 
this on, and then you can adjust the audio by raising or lowering the pink line dis-
played in the audio track.  
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You want your audio to be, most of the time, around -6 decibels, visible in the me-
ters on the right as you play the timeline. Never let your audio ‘peak out’ by hitting 
zero.  If your audio is too quiet, it will be hard to hear.
And if it is inconsistent, viewers will be driven crazy adjusting their volume levels.

Adjust the audio of individual clips by dragging up or down that pink line. 

FADE Audio
To fade audio in or out, use the Pen Tool, at the bottom of the toolbar, to set 
points,  on the pink clip overlay line. then drag those points down to create a gen-
tle fade in or out of your sound
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TIP
•

Cleaning up your audio - 

adjusting the levels of each 

clip - is part of the polish-

ing of a video.  One of the 

last steps you should do 

when editing is play your 

piece and just watch the 

audio levels.

•

TIP
•

You can fade video in the 

same way. Use the pen 

tool to set points on the 

black line at the top of the 

video track. OR go Ef-

fects>Video Transi-

tions>Dissolve>Fade In 

And Out Dissolve

•



TEXT and LOWER THIRDS

Final Cut has its own text tool. You can also create title slides in Photoshop and 
import them into Final Cut. Photoshop offers more controls over design.

Final Cut’s text tool is at the bottom of the Viewer window:

Lower Thirds is a specific text tool.  It refers to the common practice of identi-
fying someone by placing their name and title on the ‘lower third’ of the screen as 
they speak.
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Click on Controls to enter text for line one and two.  You can set the font and size 
independently of each other. Typically we make Line 2 smaller than Line 1.

Text is a more general tool that gives a single text box

Again, the Control tab will allow you to enter text.
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TIP
•

IF you want to edit your 

text AFTER you have 

placed it on the timeline, 

you need to make sure 

you are editing the clip 

you’ve created.

Put the scrubber over your 

text so you see it in the 

Canvas. THEN double click 

so it also appears in the 

Viewer. Changes you make 

in the viewer should ap-

pear in the Canvas. 

An easy mistake is to try 

and edit the version in the 

Viewer after you’ve placed 

it on the Timeline. IF you 

don’t select the text on 

the timeline by double 

clicking, you’re not editing 

it.

•



Once you have your text written. Go back to the video tab and drag it on to your 
timeline.  Place it on its own track above your video.  Text is transparent, so your 
video will show through.
RENDERING

IF the the thin grey line at the top of the timeline is any color other than grey, you 
may need to render.  Certain file types, slower computers, lots of effects, can re-
quire rendering.
Rendering is Final Cut’s way of processing the information so it can handle it easily 
and quickly and in real-time.
IF the line is green you’re probably still ok. But if the video playback is jerky or you 
get a ‘dropped frame’ warning, then render.
IF the line is orange or red you’ll probably need to render:
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TIP
•

Rendering is just for look-

ing at your video while 

editing. FCP will re-render 

the whole project again 

automatically when you 

export. So no need to ren-

der if  everything is work-

ing.



TO RENDER:  Sequence>Render All> Both

EXPORTING

When you are done editing, you need to export your video - creating a standalone 
movie file.

There are several ways to export, and MANY settings to adjust depending on your 
final needs.

To create a basic quicktime movie that you can use: 

File>Export>Quicktime Conversion:

Enter the name of your movie, and place it in the output folder in your project 
folder. 
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TIP
•

By default FCP will export 

the whole timeline. You can 

set ‘In’ and ‘Out’ points to 

export part of a timeline.

ALWAYS double check 

there are no extra clips 

hidden down the timeline 

before exporting. 

~

Click on your timeline and 

use the Shift-Z shortcut 

to reveal your entire time-

line to make sure.

•



Click options…

The exact settings will depend on what you want. Check with 
your instructor. But...if you shot HD….and as a starting point
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1. Settings: 
i. Change ‘Compressor Settings’ to best. leave everything else the same

2.  Filter:  
i. don’t touch

3.  Size: 
i. set to 1920x1080 for full HD IF your camera shoots this resolution. (The 

Nikon D90’s only shoot 1280x720)
ii. Check Deinterlace video for most cameras (Leave unchecked for DSLR 

cameras such as the D90)
4. Sound:
 	

   i.   Make sure ‘Sound’ is checked
    ii   Change Render settings to Best

Click OK, then Save, then sit back and wait. Exporting time depends on how long the video is, and 
how much rendering is required. 

When FCP is done, you should see a .mov file in your Output folder inside your project folder.

WATCH your video. Make sure everything is working and the way you want. 
	

 IS there sound?
	

 DOES the video start at the beginning and finish where it is supposed to?
	

 Any editing mistakes, or audio problems that need fixing?

IF you need to change anything, you will need to go back to your Final Cut project, make changes, 
save and re-export.

And now you’re  a filmmaker.

“If you want to tell the untold stories, if you want to give voice to the voiceless, you've got to 
find a language. Which goes for film as well as prose, for documentary as well as autobiography. 
Use the wrong language, and you're dumb and blind.”

 Salman Rushdie

! F i n a l  C u t  P r o

17



S o u n d S l i d e s
creat ing audio  s l ideshows

http://www.soundslides.com

by 

Will Yurman

Senior Lecturer
College of Communications

Penn State University
willyurman.com/links

“ I t ’s  a l l  s tor yte l l ing , you know. 
That ’s  what journa l i sm is  a l l  about .”

– Tom Brokaw, NBC News
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SoundSlides is a simple-to-use, fast method, for creating
audio slideshows for the web.

•The program is available at www.Soundslides.com
It comes in two flavors(for both PC and Mac):
Soundslides for $39.95 
Soundslides Plus for $69.95

This handout is based on Soundslides Plus.  Its additional features are worth the money.  Though 
all the basics are possible with the regular version.

Here we go:
Before you can create your Soundslides show, you must prepare your content.  Soundslides 
does NOT edit photos or audio.  A folder of jpegs and a single, edited, sound file is required 
BEFORE using Soundslides.

PREPARING YOUR PHOTOGRAPHS AND AUDIO

1. THE PHOTOS
A. Toning –

First, convert your images to the generic color profile.
         In Photoshop, Edit>Convert to Profile > Generic RGB

Images should be toned for display on the web. Slightly contrasty images 
seem to work best.  Mac users should tone their images to look a little 
bit light for their PC brethren.  PC users should think the reverse.

If you want to check your monitor, I suggest surfing to a good photo site 
and look at the images. If they look good on your computer, than you’re 
probably in good shape to tone by appearance on your screen.  I have 
used the Best of Photography competition’s test image:
http://bop.nppa.org/calibration+image.jpg

Soundslides
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B. Sizing –
Soundslides WILL resize your images.  BUT, you will have more control 
and have better quality if you size them close to your final output size at 
72dpi. 

If you know the precise size of your show, I recommend resizing your 
photos exactly.

If you are looking to develop a workflow for a department, size all photos 
to, for example, 1000 pixels across the long dimension at 72dpi.  And let 
Soundslides do the final resizing. (assuming that’s larger than any show 
you might produce – you don’t want Soundslides upsizing your 
images)

When downsizing in Photoshop use Image Size>Bicubic Sharper.

                                     

 AFTER sizing, I sharpen the image using the Photoshop ‘sharpen’ filter. 
* Underexposed, heavily toned, noisy images, may look better with unsharp 
mask.
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I have also had good luck using unsharp mask to increase local contrast.  
This is NOT a sharpening technique, but rather a way to increase the 
apparent contrast of the image with less chance of losing highlight and 
shadow detail.  Google ‘local contrast’ for more info. It’s pretty amazing.
Try these settings in Photoshop’s Unsharp Mask dialogue box

C. Saving – Save your files as jpegs at the highest quality setting.
* Soundslides can only import jpegs (NOT progressive).  The program WILL recompress 
your images. So save at the highest quality for the least jpeg artifacting.
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D. Naming & Captioning –
• IF you name your photos in sequence, 01, 02, 03…, SoundSlides will 
import them in order. 

	

 	

 • You will be able to rearrange your images manually in Soundslides.

• Captions – Soundslides will import caption information entered into 
the IPTC caption field in Photoshop or other programs such as Photo 
Mechanic.
• Captions CAN also be entered or edited from within Soundslides.

YOUR PHOTOS ARE NOW READY FOR SOUNDSLIDES…..YEA!

2. THE AUDIO
Audio must be edited in a separate editing program such as Audacity(free), GarageBand
(cheap, Mac only), PEAK, Soundtrack Pro etc.

All your sound must be in ONE sound file.  A Soundslide show can only have one 
track.  Audio files must be 16bit and have a sample rate of 44.1khz or 22.05khz. 

	


For best quality SAVE your audio file in an umcompressed format.
	

 On a Mac use the .aif format
	

 On a PC use the .wav format

*NOTE - To use aif or wav files Soundslides requires the free LAME audio encoder. 
(The same free encoder can be used for Audacity to create mp3 files). 
In Soundslides, under the HELP menu, use the LAME audio encoder button. You can 
either download it and install it automatically, OR locate the file on your computer if it is 
already installed. 

You’ll only need to do this once.

Soundslides can also import an mp3 file. But since the program compresses the sound 
into an mp3, using an uncompressed format will avoid
compressing your file twice.

If you do use an MP3 file, it must be encoded to 32kbps, 48kbps, 56kbps, 64kbps, 128kbps, 
160kbps or 256kbps.

NOW  YOU HAVE ALL THE PIECES TO CREATE YOUR VERY OWN 
SOUNDSLIDES AUDIO SLIDESHOW
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3. USING SOUNDSLIDES
A. Open the program.

Select ‘New’ – Name and Save your project  (or select ‘old’ for works in progress)                 

I use ‘SHOW’ as a tag. But you can name it anything. It is this folder you select if you 
need to reopen and reedit the show at a later date.
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B. Select an output size.  This CAN be changed later.
The size depends on your use – custom allows you to set an exact size to fit a particular 
website design.

 

C. Click on JPG and browse to and select the folder with your prepared images.  

D. Click on SND and browse to and select your audio file.
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Your screen should look something like this:

EDITING IN SOUNDSLIDES

Soundslides TABS:

SLIDES TAB - This is where the bulk of your editing will occur.  You can change the order of 
images, and their timing from this tab

REARRANGING PHOTOS
	

 Simply click and drag an image thumbnail to change the order.

ADJUSTING THE TIMELINE
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 Change how long a photo is displayed by clicking and dragging in the timeline at the 
bottom.  Click on the bar BETWEEN the images, not the images themselves. 
	

 When you click and drag, a time marker will be displayed.
	

 You can adjust the timeline WHILE the audio is playing.

Two other ways to change the timing:
1. Manually adjusting the "in point" via the Slide Info tab
2. Drag-and-drop timing.  You can drag a thumbnail down to the
timeline.  This will insert the file without altering any of the other image timings.

Zooming in for a closer look
With version 1.9.4 you can zoom in on the timeline for easier editing - especially if 
you have a lot of images in your show.  Use the slider at the far right of the 
timeline.

Also:
1. click on the white dashes under a photo to change an individual transition. (fade in, cross 
fade, straight cut)
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2. Under the menu Timeline you can spread all the images equally, or spread the remaining 
images, from where the cursor is, equally.

3.
SLIDE INFO TAB - Edit captions and use the dreaded Ken Burns effect. 

CAPTIONS
	

 Double click on a thumbnail on the right OR select SLIDE INFO to edit or input caption 
information:

New to Plus - Under SLIDE INFO - set the In Point for this image - the time the photo appears.  
Also new to Plus, the Movement option - this allows the Ken Burn-like affect of panning and 
zooming on still images. Perhaps the most overused feature of Soundslides.

TEMPLATE TAB - allows you to set various parameters for the show:

	

 Display
	

 Select options for color and controls 
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 Fonts
	

 Set size and fonts for display

	

 Transition
	

 Set the style and length of transitions between images
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 Shell
	

 Select one of several ‘shells’ that can customize the show’s 
	

 appearance and functionality.
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PROJECT INFO TAB - Enter the headline and credits for the show

PLEASE - don’t leave the headline or credit as the default. The headline will also 
appear as the name of the page in your browser.

AUDIO TAB - Re-import audio file.  
This will automatically replace the current audio track. Discard Audio to change to 
a slideshow without sound.
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Think You’re Done?
• To preview your show, use the “TEST” button.
• To save your show, use the “SAVE” button. 
• When you are done, use the “EXPORT” button to create the files you will need for your 
website.

Clicking “EXPORT” will create, and open, a publish_to_web folder     
INSIDE your project folder.  

This folder CAN be renamed. But the entire folder must be uploaded to your site. 
This often confuses people. Your overall project folder is what you edit and build. The 
publish_to_web folder is what you post. Every time you click export, you overwrite your 
publish_to_web. (Unless you’ve renamed or moved it.)

DO YOU WANT PEOPLE TO SEE YOUR WORK?

The next step is getting your show on the web.

Once you have your publish_to_web folder created, and renamed, you have many options for 
getting it on the web.

This will depend on what system you use for displaying your work: 
	

 • self-hosted  and custom-built website
	

 • self-hosted using Wordpress.org
	

 • one of many blogs such as, blogger, tumblr, etc.
	

 • a hosted site such as Wordpress.com

Other things to consider:
	

 Multiple platforms – computers, phones, tablets
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This is not a comprehensive list, but may help get you started.

A few terms:
Domain Name: This is the URL of your site – http://www.WillYurman.com for example. This 
can be an address anywhere.  You buy your Domain Name, but still need to point it 
somewhere – to your blog, tumblr, personal site, etc.

FTP: (file transfer protocol) -- an application that allows users to send and receive files 
between remote computers.  This is a common way of getting your work from your computer 
on to the Internet.  Applications range from free (FireFTP for Firefox) to inexpensive (Transmit 
for example @ $34)

Host – The computer or computer company that acts as a server for your website.  Also used 
as a verb as in 'to host a site.'
	

 When you have your own website you contract with a company to ‘host’ your files.
	

 I use Dreamhost, there are many many many many others.
	

 	



Things to know:
By default, Soundslides exports a series of files designed to play in a browser, using the Flash 
plug-in.
The newest version of Soundslides offers an additional option of creating a HTML5 compliant 
package that will play on the iPad. 
	

 To create this option in Soundslides go to Template>Shell and select html5_compatible. 

Create a link to the index.html page inside the publish_to_web folder OR consult with your 
company’s web folk for a method specific to your system.

You’re Done!

“The universe is  made of  stor ies ,
not of  atoms.”

– Muriel Rukeyser

Soundslides

http://siderealdesigns.com/website_glossary.php#server
http://siderealdesigns.com/website_glossary.php#server
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